## Table of Contents

1. Introduction
2. Logging In
3. Administrator Home Page
4. MLHGs (Multi Line Hunt Groups)
   4.1 Move MLHGs between Departments
   4.2 View MLHGs
   4.3 Hunt Group Pilots
   4.4 Hunt Group Members
   4.5 Hunt Group Settings
5. Call Pickup Groups
   5.1 Move Call Pickup Groups between Departments
   5.2 View Call Pickup Groups
   5.3 Add a Call Pickup Group
   5.4 Remove A Call Pickup Group
   5.5 Call Pickup Group Members
   5.6 Change Call Pickup Group Name
6. Lines
   6.1 Find Lines
   6.2 Move Lines between Departments
   6.3 View Line Configuration
   6.4 Reset User’s Password
7. Easy Attendant
   7.1 Easy Attendant First Time Setup
   7.2 Configure Easy Attendant Menus
   7.3 Configure Extensions Callers Can Dial
   7.4 Configure Business Hours
   7.5 Turning Easy Attendant On/Off
   7.6 Forward Calls when Easy Attendant is Off
   7.7 Switch Between Schedule/Single Menu Modes
   7.8 Record Announcements for your Initial Greeting
   7.9 Telephone User Interface
   7.10 Troubleshooting
8. Premium Attendant
   8.1 Premium Attendant First Time Setup
   8.2 Working with the Premium Attendant interface
   8.3 Configure Premium Attendant Schedule Periods
   8.4 Configure Premium Attendant Menu(s)
   8.5 Record Announcements
   8.6 Telephone User Interface
   8.7 Troubleshooting
   8.8 Configure Extensions Callers Can Dial
   8.9 Change Default Settings Premium Attendant Menus and Keys
   8.10 Turning Premium Attendant On/Off
   8.11 Forward Calls when Premium Attendant is Off
9. Phones
   9.1 Select a Department
   9.2 Find Phones
   9.3 Manage Phone Profiles
9.4 Copying Telephone Configuration
9.5 View Phones
9.6 Assign a Phone to a Department
9.7 Assign a Phone to a Business Group Line
9.8 Change Phone Information

10 Departments
10.1 View Department
10.2 Add a Department
10.3 Delete a Department
10.4 Edit Department
10.5 Department Call Limits

11 Short Codes
11.1 View Short Codes
11.2 Add a Short Code
11.3 Add a Short Code Range
11.4 Remove a Short Code or Short Code Range
11.5 Modify a Short Code
11.6 Move Short Codes between Departments

12 Extensions
12.1 View Extensions
12.2 Add or Remove Extensions

13 Call Analytics
13.1 Summary
13.2 Reports
13.3 Download Logs

14 Music on Hold
14.1 View Music on Hold
14.2 Resources
14.3 Recordings
14.4 Mappings
14.5 Telephone User Interface

15 Misc. Settings
15.1 Number Blocks
15.2 External Calls
15.3 Other Settings

16 Additional Information
1 Introduction

This guide is intended to help administrators perform the tasks needed to administer the system via the Administrator Portal, such as:

- Configure your Auto Attendant
- Set up Call Pickup Groups
- Set up Multi Line Hunt Group(s) (MLHGs)
- And much more

The Administrator Portal is supported on the latest versions of all major browsers and operating systems. This includes:

- Microsoft Internet Explorer version 6 or later
- Firefox version 3 or later
- Google Chrome version 4 or later (Windows only)
- Safari version 5 or later (Mac OS X only)

It is supported on the following operating systems:

- Microsoft Windows 2000
- Microsoft Windows XP
- Microsoft Windows Vista
- Microsoft Windows 7
- Mac OS X 10.6, Snow Leopard
- Mac OS X 10.7 (Lion)

Note: JavaScript must be enabled.

2 Logging In

- Go to https://portal.popp.com/bg/
- **Number**: enter 10-digit phone number (phone number must be set up by POPP with administrative access)
- **Password**: enter your password (the first time you log in, enter the password assigned by POPP)
- Click **Login**
- The **Administrator Home** screen will open
3 Administrator Home Page

- Once you are logged in, the administrator home page will open
- The administrator's name will appear in the upper-right corner of the screen
- Menu options are listed down the left side of the screen. Click on the desired menu option to view and change the configuration of your Cloud IP Phone System. The main panel will display the corresponding information based on the menu option selected.

4 MLHG's (Multi Line Hunt Groups)

The Hunt Groups (MLHG) screen shows all MLHGs in the selected Department.

A MLHG (aka Hunt Group) is a set of lines within a Business Group (MLHG Members), so that calls to the group are passed to a non-busy line within the Hunt Group, or may be added to a queue if all lines are busy.

Note:
- MLHG queuing does not consume WAN bandwidth
- If Call Forward No Answer is applied to a MLHG Pilot number (e.g., to voice mail), the Call Forward No Answer will override the MLHG maximum queuing time.
- If a call to a MLHG rings to a User who is in DND, that User is ineligible for the call, even if they go off DND

- Use the Hunt Groups in Department drop-down list to select the Department to view the MLHG(s) for.

A Department defines a section of a Business Group to which Lines and other functions, such as Short Codes, can be assigned. Administrator privileges for the Department can be assigned to a particular Business Group Line, without giving the Line access to the whole Business Group.

4.1 Move MLHGs between Departments

To move MLHGs between Departments:
- From the Hunt Groups (MLHG) screen, select one or more MLHGs by checking the box next to each individual MLHG in the list
- Move selected to: Select the department to move the MLHGs to
- Click Move to make the change
4.2 View MLHGs

On the Hunt Groups (MLHGs) screen, each row in the table shows the following for each MLHG:
- Hunt Group Name
- Number of Members (number of lines in the MLHG, not including the Pilot number)
- Service Level (Hunt Group, Premium ACD, etc.)

- **Click on a Hunt Group** in the list to view the hunt group’s Pilot Number(s), Hunt Group Members, and Settings.

4.3 Hunt Group Pilots

You can assign one or more MLHG Pilot Numbers to the Hunt Group. When a Pilot Number is called (internally or externally), the call enters the hunt group and is handled based on your MLHG settings. Calls that are dialed directly to a number within the Hunt Group can be forwarded to a non-busy line within the Hunt Group if the number they are calling is busy, or may be treated as busy if you prefer. Internal calls are never hunted.

From the Hunt Groups (MLHGs) screen:
- **Click on a Hunt Group** in the list to view the Hunt Group Pilot(s)
- Each row in the table shows the following for each Pilot Number:
  - Telephone Number
  - Extension
  - Name

- To view the Call Manager settings for the line, click on the **Telephone Number** and click **Go to Call Manager**

4.4 Hunt Group Members

From the Hunt Groups (MLHGs) screen:
- **Click on a Hunt Group** in the list
- **Click on Hunt Group Members** to view a list of hunt group members (lines) and their:
  - Position: A hunt algorithm selects non-busy lines to be passed incoming calls. The order in which lines are selected by this algorithm can be changed
  - Telephone Number of the line
  - Extension number of the line
  - Logged in or Logged out icon. Users who want to temporarily remove themselves from the MLHG can log in and out of the Hunt Group if the administrator has configured the MLHG to allow this (Login/Logout supported).
  - Name of the line
  - Department the line belongs to

- To view the Call Manager settings for a line, click on the **Telephone Number** and click **Go to Call Manager**
To Add a Line to a MLHG:

Note: lines from multiple departments can be part of the same MLHG. One line may be a part of multiple MLHGs.

- Click on **Add Lines**
- **Check the box** next to line(s) to be added. Only lines that are not already in the MLHG are displayed.
- **Click Add Selected**

Alternatively, you can enter the telephone number of a single line in the box next to **Add single line** and click **Add**. Line must be part of the business group.

To Remove a Line from a MLHG:

- **Check the box** next to line(s) to be removed
- **Click Remove Selected**

To Change Position of Lines in MLHG:

- **Click Change Positions**

- Click the up ▲ and down ▼ arrow icons to move lines up and down in the list
- **Click Apply to save**
4.5 Hunt Group Settings

From the Hunt Groups (MLHGs) screen:
- Click on a Hunt Group in the list
- Click on Settings:
  - Click Preferences to:
    - View/modify Hunt Group Name
    - View Service Level (Hunt Group, Premium ACD, etc.)
    - View/modify Login/logout supported by default for new members
  - Click Hunt Settings to view/modify:
    - Call Distribution Algorithm:
      - Linear: If a Pilot Number is called, hunting starts with the first MLHG line and continues through the list until a non-busy line is found. If a busy MLHG line is dialed directly and the Hunt on Direct Dialed Calls option is configured, hunting starts with the MLHG line after the dialed number and continues to the end of the list until a non-busy line is found. It does not start again from the beginning of the list.
      - Circular: If a Pilot Number is called, this is the same as Linear. If a busy MLHG line is called, this is the same as Linear except that once the end of the list is reached, hunting will continue from the beginning of the list until a non-busy line is found.
      - Uniform (Round robin): If a Pilot Number is called, hunting starts with the first line after the line that was selected by the previous hunt. When the end of the list is reached, hunting continues from the beginning of the list until it reaches the number it started with. If a busy MLHG line is dialed directly, and Hunt on Direct Dialed Calls is configured, this is the same as Circular hunting.
      - Uniform (Longest idle): If a Pilot Number is called, or a busy MLHG line is dialed directly and Hunt on Direct Dialed Calls is configured, hunting starts with the MLHG line that has been idle for the longest. The idle time for a line is calculated using the end time of any incoming or outgoing calls to or from the line, not just those allocated by hunting. When an MLHG line disables the Do Not Disturb call service, its idle time is reset to zero.
      - Ring all: If a Pilot Number is called, all lines in the MLHG will ring simultaneously.
    - Queue length: The maximum number of calls that can be queued at one time (max is 16)
    - Hunting on direct-dialed calls: Specifies if external calls placed directly to a line in the MLHG will hunt when the line is busy. (Internal calls, and external calls directly to a line with simultaneous ring enabled, do not receive Line Hunting treatment regardless of the setting of this field.)
    - Deliver Pilot's info as the Caller ID: Specifies if the outbound Caller ID number is the directory number that was called. This can be used so that, for example, a helpdesk receiving calls could know whether the "Helpdesk" or "Accounts Inquiries" number had been called.
    - Ring each member for # of seconds: Number of seconds
    - If a member does not answer, do not call again: Number of seconds
  - Click Apply to save changes
5 Call Pickup Groups

The Call Pickup Groups screen shows all Call Pickup Groups in the selected Department.

A Call Pickup Group defines a group of Business Group Lines within which the subscribers can use the Call Pickup feature (*11) to answer each other’s incoming calls. Lines belonging to different departments may be members of the same Call Pickup Group and one line may be a member of multiple Call Pickup Groups.

- Use the Call Pickup Groups in Department drop-down list to select the Department to view the Call Pickup Group(s) for.

A Department defines a section of a Business Group to which Lines and other functions, such as Short Codes, can be assigned. Administrator privileges for the Department can be assigned to a particular Business Group Line, without giving the Line access to the whole Business Group.

5.1 Move Call Pickup Groups between Departments

To move Call Pickup Groups between Departments:
- From the Call Pickup Groups screen, select one or more Call Pickup Groups by checking the box next to each individual Call Pickup Group in the list
- Move selected to: Select the department to move the Call Pickup Group(s) to
- Click Move to make the change

5.2 View Call Pickup Groups

On the Call Pickup Groups screen, each row in the table shows the following for each Call Pickup Group:
- Call Pickup Group Name
- Number of Members (number of lines in the Call Pickup Group)
- Department

- Click on a Call Pickup Group in the list to view the Call Pickup Group’s Members and Settings.

5.3 Add a Call Pickup Group

To add a Call Pickup Group:
- On the Call Pickup Groups screen, click Add Group
- Enter a Call Pickup Group Name
- Click Add

5.4 Remove A Call Pickup Group

To remove a Call Pickup Group:
- On the Call Pickup Groups screen, check the box next to the Call Pickup Group(s) to be removed
- Click Delete Selected
5.5 Call Pickup Group Members

To view Call Pickup Group Members:

- On the Call Pickup Groups screen, click on a Call Pickup Group to view a list of Members (lines)

To Add a Line to a Call Pickup Group:

- Click on Add Lines
- Check the box next to line(s) to be added. Only lines that are not already in the Call Pickup Group are displayed.
- Click Add Selected

Alternatively, you can enter the telephone number of a single line in the box next to Add single line and click Add. Line must be part of the business group.

To Remove a Line from a MLHG:

- Check the box next to line(s) to be removed
- Click Remove Selected

5.6 Change Call Pickup Group Name

To change a Call Pickup Group Name:

- On the Call Pickup Groups screen, click on a Call Pickup Group
- Click Settings
- Call Pickup Group Name: Enter a new name
- Click Apply to save

6 Lines

The All Lines screen shows all individual lines, Easy/Premium Attendants, and MLHG (Multi Line Hunt Group) pilot lines in a Business Group or Department.

- A Business Group is a logical container in the Metaswitch software that groups together telephones, lines, and features common to a single business
- A Business Group Line is an individual line within a Business Group
- An MLHG is a set of lines within a Business Group (MLHG Members), so that calls to the group are passed to a non-busy line within the Hunt Group, or may be added to a queue if all lines are busy

- Use the Lines in Department drop-down list to select the Department to view the Lines for.

A Department defines a section of a Business Group to which Lines and other functions, such as Short Codes, can be assigned. Administrator privileges for the Department can be assigned to a particular Business Group Line, without giving the Line access to the whole Business Group.

6.1 Find Lines

If you only have a few lines in your Business Group or selected department, you may be able to find a line by manually looking at the list of lines.
Alternatively, you can search for the line you are interested in based on phone number, extension number or name. Enter the number or name you wish to find in the Search for... input box, and the list of lines will automatically update to only show lines that match. If you wish, you can restrict your search to only match on a given field by using the search field drop-down to the right of the search box.

6.2 Move Lines between Departments

Note: A line may be a member of multiple departments. MLHG pilot numbers cannot be selected.

To move lines between departments:

- Check the box next to each individual phone number in the list that you would like to move. Or check the box next to Telephone Number at the top of the list to select all.
- Select the department to move the lines to, using the Move selected to dropdown field
- Click Move to move the line(s)

6.3 View Line Configuration

The All Lines screen includes the following information for each line/MLHG pilot number:

- Telephone Number
- Extension
- Name: The name and icons indicate whether the line is an individual line, MLHG pilot, Easy Attendant or Premium Attendant
- Department (if viewing all lines in the business group)
- Actions:
  - View individual settings: This option gives the administrator access to the User Portal (portal opens in a new window) without requiring the end user’s password in order to view/modify Call Manager settings (by clicking on Call Settings) or reset the User’s password (see instructions below).
    - Note: You will not be able to see or listen to User’s voicemails.
  - View group settings (for MLHGs pilot numbers)
  - Edit personal details
  - Reset line
  - Unlock account

6.4 Reset User’s Password

- Under Actions, select View Individual Settings:
  - Click on View Account Settings
  - Click on Change Password
  - New password: Enter new password
  - Confirm new password: enter password again
  - Click Confirm to save
7 Easy Attendant

Easy Attendant is an automated receptionist service. When turned on, it answers your calls automatically, and offers your callers a list of options (a "menu") that you define. You can allow your callers to listen to messages (such as your business hours), to leave a message, or to be transferred to a real person.

For example:
Welcome to Bob's Tires. We are open for business right now. To hear directions to our store, press 1. To hear our business hours, press 2. If you know the extension of the person you require, press 3.

If you wish, you can offer your callers different menus depending upon whether you are currently open or not.

For example, when Bob’s Tires is closed, they might offer this menu instead:
Welcome to Bob’s Tires. Unfortunately, we are currently closed. To hear directions to our store, press 1. To hear our business hours, press 2. If you wish to leave a message, press 3, and we will get back to you as soon as possible.

Once you have configured Easy Attendant with the hours and days that you are open, it will automatically play the correct menu for callers depending on when they call.

7.1 Easy Attendant First Time Setup

To set up your Easy Attendant for the first time:

- **Step 1** - Open the Easy Attendant settings:
  - From the Administrator Portal Home screen, click on the **Attendants** menu option
  - Click on the **Easy Attendant** in the list
  - Click on **Open Attendant Settings**
  - Choose whether to offer callers different menus during business hours and outside of business hours. Easy Attendant is set to use a single menu by default. To use a schedule (one menu for business hours and another menu for non-business hours), click **Switch to using a schedule**

- **Step 2** - Configure a number to forward callers to while your Easy Attendant is turned off. If you skip this step, callers to your Easy Attendant will be played a message saying this number is unreachable.

- **Step 3** - Configure menu(s) callers will hear by clicking on **Easy Attendant Menu** (if using a single menu) or **Business Hours Menu/Non-Business Hours Menu** (if using a schedule)
  - If a menu includes the option to dial by extension or name, configure the extensions callers can dial
  - If you choose to use a schedule, configure your business hours

- **Step 4** - Turn ON Easy Attendant
7.2 Configure Easy Attendant Menu(s)

Your Easy Attendant menu configuration determines what options/announcements callers will hear.

If you have chosen to use a single menu (offer the same options at all times), you will need to configure a single "Easy Attendant Menu". In each case, you can select the menu or menus you need to configure using the corresponding tabs at the top of your Easy Attendant page.

If you have chosen to use a schedule (offer different options during business hours and outside of business hours), you will need to configure two separate menus - a Business Hours Menu and a Non-Business Hours Menu.

An Easy Attendant menu consists of the following:

- **Initial Greeting**: This is the first thing that callers hear. The initial greeting lists the menu options callers can choose from:

  **Example:**
  "Welcome to Bob's Tires. We are open for business right now. To hear directions to our store, press 1. To hear our business hours, press 2. If you know the extension of the person you require, press 3."

- **Functions**: Details of what should happen when a caller selects a particular option. For example, as part of setting up the Easy Attendant for Bob's Tires, you would configure key 1 to play an announcement and then record the announcement giving directions to the store.

Follow these instructions to set up each menu (business hours and non-business hours (if applicable)):

- Open the Easy Attendant settings:
  - From the Administrator Portal Home screen, click on the Attendants menu option
  - Click on the Easy Attendant in the list
  - Click on Open Attendant Settings

- If using a single menu, continue to the next step. If using a schedule, click on Switch to using a schedule

- Click on a menu to configure (Easy Attendant Menu (single menu) or Business Hours Menu/Non-Business Hours Menu (if using a schedule)):

- **Assign Functions**: assign a function for each key on the caller’s phone:
  - **Unassigned**: If a caller presses this key, they will be told that the option is not recognized
  - **Play Announcement**: If a caller presses this key, they will hear a message that you have recorded:
    - You must record the announcement you want to play, by clicking on the record icon that appears to the right of the dropdown.
  - **Transfer to Phone**: If a caller presses this key, they are transferred to a phone number of your choice e.g., "press 4 to speak to a sales representative").
    - You must enter the 10-digit phone number you wish to transfer to in the box to the right of the drop-down.
  - **Dial by Extension**: If a caller presses this key, they can choose who to speak to by dialing an extension number.
    - You must also define the set of extensions that your callers can enter and the phone numbers that each will transfer to.
    **Note**: Do not attempt to do this until you have finished configuring your menu and have applied your changes.
  - **Dial by Name**: If a caller presses this key, they can choose who they want to speak to within your organization by dialing their name.
    - You must also define the set of extensions that your callers can enter, their names and phone numbers that each will transfer to.
    **Note**: Do not attempt to do this until you have finished configuring your menu and have applied your changes.
7.3 Configure Extensions Callers Can Dial

If you have chosen to offer your callers a Dial by Extension or Dial by Name option, then you can configure the set of extensions they can dial in two ways:

Business Group Extensions

Business Group extensions are the list of extensions within your business group. A list of all extensions in your business group is displayed in the "Extensions" tab.

To configure business group extensions to be included in Dial by Extension and Dial by Name:
- Click on the Business Group Extensions tab at the top of the Easy Attendant screen
- Check the box next to each extension to be included in the list available to callers and click Include Selected
- Included lines will display a check mark in the Included column
- Any new lines added to the business group will automatically be included in or excluded from the set available to callers, based on the Automatically include new extensions as they are added to the Business Group setting (at the bottom of the Extensions screen). Click on this setting to change it if desired.

To include selected lines in Dial by Name actions, you need to make sure that a name recording is available for the line. The name recording can come from one of two places:
- If the line does not have a name recorded for voicemail, record or upload a business group name recording by clicking the Record link for the line
- If the line already has a name recorded for voicemail, the voicemail name recording will be used as the Dial by Name recording. Click the green "override" link to record a business group name to be used instead.
- Lines with a business group name recording display a green "listen/change" link, allowing you to listen to or replace your existing recording.
- If a line has both a voicemail and a business group name recording available, the business group name recording will be used.

Additional Extensions
To use additional extensions, you must define the set of extensions which callers can dial. For each extension you must specify the 4-digit extension number, the extension’s name and the phone number that your caller should be transferred to if they dial this extension.

To configure Additional Extensions:
- Click on the Additional Extensions tab at the top of the Easy Attendant screen
- Click on Add Extension:
  - **Extension**: This is the 4-digit extension number that your callers will dial. It cannot match any other extensions you have already configured.
  - **Name**: This is the name that your callers will dial. Both the first and last name must contain at least 2 dialable characters.
  - **Telephone Number**: This is the 10-digit telephone number that callers will be transferred to if they dial this extension
- You will also be prompted to record a spoken name for this extension. This is played to callers if they enter a name that is not unique to allow them to refine their search. For example, if there are two extensions called "John" and the caller enters "John", they hear the full names of both the extensions and can choose between them. Extensions that don't have a spoken name recorded can't be reached by "dial by name" options.

To delete existing extensions, check the box next to extension you wish to delete, and then click on Delete Selected.

### 7.4 Configure Business Hours

If you have chosen to offer your callers different options during business hours and outside of business hours, you must configure a business hours schedule. This tells Easy Attendant what your business hours are, so that it can automatically offer callers the correct menu based on when they are calling. To configure your schedule, click on the Schedule tab at the top of the Easy Attendant page.

To configure your schedule:
- Click an option to use an example schedule (recommended) or a blank schedule
- Configure your normal business hours, for each day from Monday to Sunday. To do this, simply "color in" the grid with the hours that you work by clicking on the appropriate cells (1-hour increments). For 15 minute increments, click Zoom in at the bottom of this screen. Clicking on a cell in the grid toggles it between business hours and non-business hours. You can change several cells at once by clicking and dragging.
- Configure any special one-off dates when your business will be closed. To do this, click on the button to bring up the calendar control, and select dates when you will be closed by clicking on them. If you always close on public holidays, you can easily select all of these by clicking on the Add Public Holidays button.

- When you have finished, click on Apply to save your changes.

7.5 Turning Easy Attendant On/Off

To turn your Easy Attendant on or off:
- Navigate to the Main tab at the top of the Easy Attendant screen and click the Turn ON or Turn OFF button.

When your Easy Attendant is turned off, callers will either hear an announcement stating that “this number is unreachable” or will be forwarded to a number of your choice. It is common to leave your Easy Attendant turned on all of the time, but (depending upon how Easy Attendant has been deployed) you may, for example, wish to turn Easy Attendant off during the day and forward your callers directly to a live receptionist instead.

7.6 Forward Calls when Easy Attendant is Off

When your Easy Attendant is turned off, you can choose either for callers to:
- Hear a message telling them that the number is unreachable
- Be forwarded to an alternative number

To change this setting, your Easy Attendant must first be turned off. The text at the top of the Main Easy Attendant tab will then read either “Your Easy Attendant is currently OFF and callers will be told that this number is unreachable”, or “Your Easy Attendant is currently OFF and callers are being forwarded to [nnn-nnn-nnnn]”. To change the current setting, click on the link included in this message.

7.7 Switch Between Schedule/Single Menu Modes

Easy Attendant has two different modes:

- **Schedule mode:** In schedule mode you set up two separate menus - one for use during business hours, and one for non-business hours. The system then automatically plays the correct menu to a caller depending on when they call. For example, during business hours you might want to offer your callers a choice of people to speak to. Outside of office hours, you might instead want to offer the option of leaving a message.

- **Single menu mode:** In single menu mode, you set up just one menu. All callers will hear the same menu regardless of the time of day.

You can switch between these modes at any time by clicking on the link on the Easy Attendant screen to Switch to using a single menu or Switch to using a schedule.
To switch from single menu mode to schedule mode:

- If Easy Attendant is currently turned on, you must turn it off (by clicking on the "Turn OFF" button) before proceeding. The service will be turned off for a while as you set up your new configuration, so you may wish to forward callers to an alternative number while you carry out the rest of this procedure.
- Click on the Switch to using a schedule link
- In schedule mode, you will have two separate menus - one for use during business hours and one for during non-business hours. If you have already defined a menu (when running in single menu mode) you can keep this and use it as the starting point for one of the two menus you will be using from now on. Or you can change it if desired.
- You are now running in schedule mode. Before you can turn Easy Attendant on again, you must configure your business hours menu, your non-business hours menu and your schedule (See Configure Easy Attendant Menu and Configure Easy Attendant Business Hours instructions). This is very similar to setting up an Easy Attendant for the first time, except that you may already have some configuration for one of your menus.
- Choose “Base my Business Hours Menu on my existing Easy Attendant menu” or “Base my Non-Business Hours Menu on my existing Easy Attendant menu” and click OK.

To switch from schedule mode to single menu mode:

Warning: in schedule mode, you have two separate menus -- one for use during business hours and one for use during non-business hours. Switching to single menu mode will cause one of these menus to be permanently deleted (you can choose which one you wish to keep). Switching to single menu mode will also permanently delete any business hours schedule you have configured. If you subsequently wish to return to schedule mode, you will need to set these up again.

- Navigate to the Main tab at the top of the Easy Attendant screen.
- You may wish to turn Easy Attendant off, and optionally forward callers to an alternative number while you carry out the rest of this procedure.
- Click on the Switch to using a single menu link.
- If you had previously set up both your business hours menu and your non-business hours menu, you will be asked which one you wish to keep. The other menu is permanently deleted.

7.8 Record Announcements and your Initial Greeting

When using Easy Attendant, all announcements that are played to your callers must be recorded by you in advance. At the very least, this requires you to record an initial greeting, but you may also wish to record a number of other announcements giving your callers information such as your business hours (See Configure Easy Attendant Menus).

Easy Attendant offers two ways to record your announcements:

- If your computer has a sound card and microphone, you can use these to record your announcements directly from the Easy Attendant configuration pages. If your computer does not have a microphone built in, you may plug a microphone into your computer to allow you to record your Easy Attendant announcements.
- Alternatively, if you do not have the necessary equipment (or if you simply prefer), you can record your announcements using your telephone (see Telephone User Interface).
Recording announcements directly from your computer

Anywhere you see a record icon you can click on the link to bring up the announcement recording control. This allows you to record your announcement directly via your computer’s microphone.

Once you have recorded an announcement, the record will change to listen/change. Clicking on this will again bring up the announcement recording control, which will enable you to play back, and if you wish, overwrite your recording.

Recording an announcement

When you first attempt to record an announcement, an "Adobe Flash Player Settings" overlay will appear. Ensure that the "Allow" radio button is selected, and if you do not wish to be shown these settings in future click on the "Remember" checkbox.

- When you are ready to record your announcement, click on the record button.
- Read your announcement into your microphone, and when you have finished, click on the record button.
- Playback your announcement to check that it has recorded correctly by clicking on the play button. If you want to stop the playback, click on the stop button. If there is a problem with the recording, e.g. you cannot hear it, or it is very quiet, see the section on troubleshooting below.
- If you are not happy with your announcement content, then record a new announcement by clicking on the record button again. This will overwrite your previous announcement.

7.9 Telephone User Interface

You may also use the telephone interface to record and listen to your Auto Attendant greeting(s):

- Dial 651-789-7688 from your telephone and enter:
  - Auto Attendant phone number (provided by POPP)
  - 4-digit PIN (default PIN is 7677)
- Follow the prompts to record and listen to your Auto Attendant greetings
7.10 Troubleshooting

I have recorded my announcement, but when I try to play it back I cannot hear anything

- Verify that you have actually recorded something. The length of the current recording is shown as e.g. 0:01:35 (1 minute and 35 seconds). If the current recording length is 0 or much lower than expected, try recording your announcement again.
- Verify that playback volume is turned up high enough. Volume can be adjusted using the volume slider.
- Try re-recording the announcement, and as you are recording, watch the lights on the player:
  - If no lights appear, or only one or two appear, then check the following.
    - Increase the gain of your microphone by clicking on and moving the gain control nearer to the top end.
    - Click on the icon to bring up the “Adobe Flash Player Settings” and make sure that the Allow option is selected. Click on the microphone icon at the bottom of this settings box and check that the correct microphone is selected in the dropdown, and that the record volume is turned up.
    - If you are using an external microphone, check that this is plugged in correctly.

If this still doesn't solve the problem, then it may be that your microphone has been muted by the operating system (e.g. Windows) - refer to your operating system help for further information.

- If several green lights appear consistently while recording your announcement, then it is likely that your announcement has recorded correctly and the problem is occurring when playing it back. If you are using external speakers, check that these are plugged in correctly and turned on. If this does not resolve the problem, then it may be that your speaker has been muted by the operating system (e.g. Windows) - refer to your operating system help for further information.

I have recorded my message, but when I try to play it back it is distorted

- This may be because your microphone gain is set too high. Reduce the gain by clicking on and moving the gain control nearer to the bottom.
8 Premium Attendant

Premium Attendant is a self-managed automated attendant receptionist service allowing you to configure a flexible set of menus for callers to your business. When turned on, it answers your calls automatically, and offers your callers a list of options (a "menu") that you define. You can allow your callers to listen to announcements (such as your business hours), leave a message, or be transferred to a live person.

For example:
Welcome to Bob’s Tires. We are open for business right now. To hear directions to our store, press 1. To hear our business hours, press 2. If you know the extension of the person you require, press 3. If you know the name of the person you require, press 4, and then enter their name followed by the pound key.

You can create different menus for different times of the day and week that play according to the pre-defined schedules that you have created.

For example:
Welcome to Bob’s Tires. Unfortunately, we are currently closed. To hear directions to our store, press 1. To hear our business hours, press 2. If you wish to leave a message, press 3, and we will get back to you as soon as possible.

Once you have set up Premium Attendant with these schedules and menus and recorded the necessary announcements, it will automatically play the correct menu for callers depending on when they call.

8.1 Premium Attendant First Time Setup

You may find it helpful to map out your Premium Attendant menu and schedule period structure on paper first, particularly if you will have several schedule periods and complex menu options.

To setup your Premium Attendant for the first time:

• **Step 1** – Open Premium Attendant Settings:
  o From the Administrator Portal Home screen, click on the Attendants menu option
  o Click on the Premium Attendant in the list
  o Click on Open Attendant Settings
• **Step 2** - Optionally, Configure a number to forward callers to when your Premium Attendant is turned off. If you skip this step, until you have finished setting up the service, callers to your Premium Attendant will be played a message saying this number is unreachable.
• **Step 3** - Configure the menus that you wish to offer your callers during the different schedule periods that you have just created
• **Step 4** - Record the announcements that your caller will hear for the menu options that require them
• **Step 5** - If you chose to offer the option to use Dial by Extension, Dial by Name, Voicemail by Extension or Voicemail by Name, configure the extensions your callers can dial.
• **Step 6** - Use the Advanced Settings tab if you wish to change the default settings for the keys used in your menus or the way in which Premium Attendant handles caller error.
• **Step 7** - Turn On Premium Attendant
8.2 Working with the Premium Attendant interface

The Schedule, Menus and Announcements tabs in the Premium Attendant interface have a yellow introduction-style panel that you will see the first time you access the tab. This outlines the basic tasks that you need to undertake under this tab to set up your Premium Attendant. On the Schedule tab, this is the only time you will be able to see this information - as soon as you save something on the page, it is not possible to return to seeing the first time hint. On the Menus and Announcements tabs you will continue to see the introductory panel whenever you delete the last menu or announcement. The Extensions tab displays helpful information on setting up extensions whenever there are no extensions.

- If there are existing items already created, upon first visiting the Schedule, Menus, Announcements and Extensions tabs:
  - The buttons Add ... and Delete ... are enabled
  - Clicking on Add ..., brings up a blank configuration allowing you to create a new schedule, menu, announcement or extension
  - The search box can be used to find an existing item by typing in:
    - All or part of the name on the Schedule and Menus tab
    - All or part of the ID, name or description on the Announcements tab
    - All or part of the extension number, name or description on the Extensions tab
- As soon as you make an edit on a page:
  - Apply and Cancel buttons become enabled
  - Add ... and Delete ... buttons become disabled
  - The search box becomes grayed out and unusable
  - Any attempt to switch menus or navigate to another tab without applying or cancelling your changes, results in a pop-up warning you that there are uncommitted changes on the current tab.

Names and descriptions

Each element of Premium Attendant (schedules, menus, announcements, recordings) has a name and description, that you will be prompted to enter in a pop-up screen when the Add New button is clicked:

- Name can be up to 40 characters long. The name can be changed after initial setup and links between menus are automatically updated. The name of each element must be unique.
- Description can be up to 256 characters long. The description can be changed after initial setup.
- The name and description are not saved until you click Apply on the main page
- Hovering over an item once it is selected shows a tooltip including its name or description

Error icons

The Premium Attendant interface uses the following error messages and icons to alert you to an incorrect or missing configuration. These are produced on page load and are not updated dynamically:

- The Main tab has a Service Status panel that states your current schedule period and the menu that callers will hear. It also reports if you have errors in any menus, or one or more announcements is missing audio.
- The Schedule and Menus pages use a banner line to report any errors.
- The following icons are used to indicate incorrect or incomplete configuration
  - Error icon
  - Warning icon
- If there are any errors in your configuration, you will be warned against turning on Premium Attendant, and in some cases, this will be prohibited.
8.3 Configure Premium Attendant Schedule Periods

You can configure up to ten Premium Attendant schedule periods (including "at all other times" and "special days" periods). For example, you might create one schedule for your normal working hours, a second schedule to cover the lunch period and an all other hours schedule for when your business is closed. You can create a separate menu for each of the schedules that you define.

Create a new schedule

- If this is the first time you have opened the Schedule tab, you can click on the links to either use a blank schedule or an example schedule as the basis for your new schedule. At all other times, use the Add New Period button to create a new schedule. You will see a warning pop-up if you attempt to add a new period once you have configured the maximum number of schedule periods.
- You will be prompted to give the new schedule a unique name, and a description.
- For each schedule that you create, you should configure the hours, for each day from Monday to Sunday, when this schedule should apply. You do this by "coloring in" the grid by clicking on the appropriate cells. You can change several cells at once by clicking and dragging. Each schedule period is shown in a different color.
- Each schedule must have an associated menu before you can turn your Premium Attendant on. You can either choose an existing menu from the dropdown list or use the 'create new menu' option to add a new one.
  - If you select create new menu you will then be prompted to enter a unique name and a description for the menu. You can only use this option if your Premium Attendant is turned off. You will configure this menu and its announcements later in the set-up process.

Once you have created them, these schedules are shown in alphabetical order in the Periods panel on the Schedules tab. If there are any errors in any of these schedules, you will see an icon alongside the schedule name. You can subsequently edit a schedule by selecting it, making your required changes, and then clicking on the Apply button to save your updated schedule.

There are two schedule periods already created in this list to cover all other times and special days:
- The all other times schedule is used at the times that are not defined in any of your other schedules. This schedule is always the second to last schedule in the list and is colored in white.
- The special days schedule covers public holidays and other special one-off days when your business is closed. This schedule is always the last schedule in the list and is colored in black.
  - Select this schedule and use the calendar to configure any special one-off dates to be included.
  - If you always close on public holidays, you can easily select all of the public holidays for your locale by clicking on the Add Public Holidays button.
  - When you have finished editing the schedule, click on Apply to save your changes.

On first use, these schedules will be shown as having errors until you have specified the working hours menu that you wish to associate with each of these schedules. You will not be able to turn Premium Attendant on until you have selected these menus and created the necessary announcements. These two schedules cannot be deleted or renamed.

Switching between schedule periods

If your Premium Attendant is turned on, you can only switch from one period to another if the currently selected period has no errors in its menu selection.
8.4 Configure Premium Attendant Menu(s)

Your Premium Attendant menu configuration determines what options your callers are offered, and what announcements they hear. The following instructions describe how to set up and edit your Premium Attendant menus. You will need to repeat these steps for each menu that you need to create.

A list of existing menus will always be visible in the left-hand side of the Menu screen. Ensure that you have the correct menu selected before making any changes.

Configuring a Menu

- Click on the Menus tab:
  - Use the General tab to Add New Menu or select an existing menu on the left side of the screen to edit or delete it
  - Use the Keys tab to assign actions to the keys that a caller can press to navigate the menu
- Use the Timeout tab to override the default timeout behavior for this menu
- Use the Reference tab if you want to see if any other menus or periods refer to this menu when editing or deleting a menu

General tab

Use the General tab to configure the menus to be associated with different schedule periods. Existing menus are listed on the left-hand side of the screen, and an icon will be shown alongside any menus that have errors. The General tab will display a message if a selected menu has errors or warnings and all menus that contain errors or warnings will have an icon alongside their name indicating this. These will be dismissed once these errors are fixed or the warnings resolved, and Apply has been clicked to save the changes.

- From the Menu tab of the Premium Attendant screen, click on the General tab
- To add a new menu, click on the Add New Menu button
  - You will then be prompted to add a unique name and a description for this menu
  - You must specify the menu announcement to be used for this menu using the drop-down box. You can either choose an existing menu announcement or opt to create a new one for this menu. You will record this announcement later in the setup process.
- To edit an existing menu: Select the menu that you want to edit from the list on the left-hand side of the screen or use the Search field to search for the name
- To delete a menu: Select the menu from the list on the left-hand side and click on the Delete button
  - You will see a pop-up asking for confirmation that you wish to delete it
  - You will also see a pop-up warning if this menu is referenced by another menu or period
  - If your Premium Attendant is turned on, you cannot delete a menu that is referenced by a period. If you attempt to delete a referenced menu, a pop-up will indicate which of your period(s) use this menu. You will need to change the menu associated with these schedule period(s) before you can delete the menu you have currently chosen to delete.

Keys Tab

Use the Keys tab to specify what should happen when a caller selects a particular option from your menu:

- From the Menu tab of the Premium Attendant screen, click on the Keys tab
- Ensure that the correct menu is selected on the left-hand side of the screen
- Configure the options that you want to offer to your callers on the selected menu:
  - The screen lists the keys 1-9, 0, # and *. Alongside each key, you will see a drop-down box, which you can use to select what will happen when a caller presses that key on their telephone while in this particular menu. For each option that you wish to offer your callers, decide which key they will press to access it, and select the appropriate option from the corresponding drop-down. For example, if you want to play an announcement describing your business hours when a caller presses 1, you would assign key 1 to 'Announcement-return'.
  - Choosing an action from the drop-down box brings up any details that need to be completed in the next column: in the above example, you would need to enter the name of the announcement to be used.
  - An icon will display next to a key assignment to indicate if there are any configuration errors (e.g., if an announcement is missing audio).
For each key you can choose from the following options.

- **Use Default**: If a caller presses this key, they experience the global key configuration for this event (set using the Advanced tab). This option is selected by default for all keys on new menus. If you select this option for a key, the default value will be shown in the next column as a link to the Default keys page on the Advanced Settings page. You can change the default behavior of these keys as described in Advanced Settings. If the default value is 'Do Nothing', a caller will be told that the option is not recognized if they press this key.

- **Transfer to Phone**: If a caller presses this key, they are transferred to a phone number of your choice. For example, you might want to allow callers to "press 4 to speak to a sales representative". You must also enter the 10-digit phone number you wish to transfer to in the box that will appear to the right of the drop-down.

- **Transfer to Voicemail**: If a caller presses this key, they will be transferred directly to a voice mailbox of your choice and invited to leave a message. For example, you might want to allow callers to "press 5 to leave a message for a member of our sales team". You must enter the 10-digit phone number of the mailbox you wish to transfer to in the box that will appear to the right of the dropdown.

- **Dial by Extension**: If a caller presses this key, they can choose who they want to speak to within your organization by dialing an extension number. If you assign a key to Dial by Extension, you must also do the following.
  - Define the set of extensions that your callers can enter, their names and the phone numbers that each will transfer to.
  - Note: Do not attempt to do this until you have finished configuring your menu and have applied your changes.
  - Give your callers suitable instructions as part of your menu announcement. For example, if you assign key 4 to Dial by Extension, then your menu announcement should include wording similar to: "if you know the name of the person you require, press 4, and then enter the extension followed by the pound key."

- **Dial by Name**: If a caller presses this key, they can choose who they want to speak to within your organization by dialing their name. If you assign a key to Dial by Name, you must also do both of the following.
  - Define the set of extensions that your callers can enter, their names and the phone numbers that each will transfer to.
  - Note: Do not attempt to do this until you have finished configuring your menu and have applied your changes.
  - Give your callers suitable instructions as part of your menu announcement. For example, if you assign key 4 to Dial by Name, then your menu announcement should include wording similar to: "if you know the name of the person you require, press 4, and then enter the name followed by the pound key."

- **Voicemail by Extension**: If a caller presses this key, after entering the required extension number, they are transferred directly to a mailbox without ringing the subscriber's telephone. You will see a pop-up if you enter a number that doesn't have a mailbox. If you assign a key to Voicemail by Extension, you must also do both of the following.
  - Define the set of extensions that your callers can enter and the phone numbers that each will transfer to.
  - Note: Do not attempt to do this until you have finished configuring your menu and have applied your changes in step 4.
  - Give your callers suitable instructions as part of your menu announcement. For example, if you assign key 4 to Voicemail by Extension, then your menu announcement should include wording similar to: "if you know the extension of the person you wish to leave a message for, press 4, and then enter the extension followed by the pound key."

- **Voicemail by Name**: If a caller presses this key, after entering the required name, they are transferred directly to a MetaSphere mailbox without ringing the subscriber's telephone. You will see a pop-up if you enter a name that doesn't have a mailbox. If you assign a key to Voicemail by Name, you must also do both of the following.
  - Define the set of extensions that your callers can enter, their names and the phone numbers that each will transfer to. Note: do not attempt to do this until you have finished configuring your menu, and have applied your changes in step 4.
  - Give your callers suitable instructions as part of the announcement. For example, if you assign key 4 to Voicemail by Name, then your announcement should include wording similar to: "if you know the name of the person you wish to leave a message for, press 4, and then enter the name followed by the pound key."

- **Transfer to Operator**: If a caller presses this key, they are connected to the operator number configured in the Business Group. This action only allows callers to connect to the operator on this pre-defined number. You cannot change the operator number in the Premium Attendant interface.
• **Intercept Mailbox**: If a caller presses this key, they are transferred to the mailbox configured globally for Premium Attendant. The phone number for this mailbox is configured using the Advanced, Other Settings tab.

• **Go to Menu**: If a caller presses this key, they are transferred to another Premium Attendant menu. You should select the menu from the dropdown box or choose 'create new menu', entering a unique name and description for this menu in the pop-up that will appear. If you subsequently delete the menu linked to on this key, the dropdown will display 'Select menu' and the key action will be marked with an error.

• **Return to Previous Menu**: If a caller presses this key, they are returned to the previous menu. If there is no 'previous menu' to return to, Premium Attendant will simply replay the current menu.

• **Replay Menu**: If a caller presses this key, Premium Attendant replays the current menu.

• **Announcement – Return**: If the caller presses this key, they will hear an announcement and then be returned to the menu. You should use the drop down box to select the announcement to use or create a new one.

• **Announcement Hang-up**: If the caller presses this key, they will hear an announcement and Premium Attendant will then hang up the call. You should use the drop down box to select the announcement to use or create a new one.

• **Hang-up**: If a caller presses this key, Premium Attendant hangs up the call without playing an announcement.

- Apply the changes you have made to your menu configuration by clicking on the **Apply** button at the bottom of the screen.

After you have set up your menu configuration, you can change it at any time by reassigning keys or updating announcements. If you change the options that you offer to your callers, you must re-record your initial greeting to align with the new options caller will hear.

**Timeout options**

To change the timeout setting for menu(s):

- Navigate to the correct timeout option:
  - To change the timeout setting for all menus: From the Premium Attendant screen, click **Advanced**
  - To change the timeout setting for an individual menu: From the Menus screen, select the menu and click **Timeout**

- Set the new timeout duration in the drop-down box. You can enter any value between 0 and 10.
  - Specify the action to be taken if a caller fails to press a key or to select a valid extension or name to transfer to within this time.
  - Click Apply to save

**References**

The References tab shows which menus and schedule periods refer to the menu currently selected on the left-hand side.

To check if a menu is referred to by another menu or schedule:

- Navigate to the References tab by clicking on the Menu tab in Premium Attendant.
- Select the menu you want to check the references for.
- You will then see a list of all the menus and schedule periods that use this menu. You can click on these links to go to these menus and schedules, for example if you want to change the menu that these reference.
- If there are no references, you will see the message 'This menu is not referenced'. This feature is useful if you want to delete a menu, as you can only do this if the menu is not referenced by any menus or schedule periods.
When using Premium Attendant, all announcements that are played to your callers must be recorded by you in advance.

Premium Attendant offers two ways to record your announcements:

- If your computer has a sound card and microphone, you can use these to record your announcements directly from the Premium Attendant configuration pages. If your computer does not have a microphone built in, you may plug a microphone into your computer to allow you to record your Premium Attendant announcements.
- Alternatively, if you do not have the necessary equipment (or if you simply prefer), you can record your announcements using your telephone (see Telephone User Interface).

**Recording announcements directly from your computer**

Anywhere you see a record icon you can click on the link to bring up the announcement recording control. This allows you to record your announcement directly via your computer's microphone.

Once you have recorded an announcement, the record will change to listen/change. Clicking on this will again bring up the announcement recording control, which will enable you to play back, and if you wish, overwrite your recording.

**Recording controls**

A number of controls are provided for recording your announcement:

- **Start recording.** This will overwrite any announcement you have previously recorded
- **Stop recording the announcement**
- **Play back your recorded announcement.** This action will be unavailable if you have not yet recorded an announcement.
- **Stop playing the announcement**

- **This control allows you to adjust the gain of your microphone.** Click on and then adjust the slider to set the required volume level. While recording, the lights above this control will show how loud the signal is from your microphone. If the gain is set correctly then several green lights should appear while you are recording. If only one or two appear, then the gain is set too low and your recording will be too quiet. If red lights appear then the gain is set too high and your recording will be distorted.

- **This control allows you to adjust the playback volume.** Click on and then adjust the slider to set the required volume level.

- **This control allows you to view and change your Adobe Flash Player Settings, for example to adjust the settings for your microphone**

When you first attempt to record an announcement, an "Adobe Flash Player Settings" overlay will appear. Ensure that the "Allow" radio button is selected, and if you do not wish to be shown these settings in future check the "Remember" checkbox.
To record an announcement:

- When you are ready to record your announcement, click on the record button.
- Read your announcement into your microphone, and when you have finished, click on the play button.
- Playback your announcement to check that it has recorded correctly by clicking on the play button. If you want to stop the playback, click on stop. If there is a problem with the recording, e.g. you cannot hear it, or it is very quiet, see the section on Troubleshooting below.
- If you are not happy with your message content, then record a new announcement by clicking on the record button again. This will overwrite your previous announcement.

Recording options drop-down field

You can use the recording options drop-down field to select from the following three options:
- **Record/Play Announcement**: If a recording has already been completed, you may listen to the announcement.
- **Upload announcement**: This will show the current filename and duration if audio already exists for this announcement. You should use the 'Browse' button to find required file, select it and then click on 'upload' to upload it. You will see a warning message if the file is not in a valid wav format, no recording has been selected, the recording is too long or the file is too big.
- **Record by Phone**: This option provides the announcement number you will need to dial in order to record the announcement using the Telephone User Interface.

8.6 Telephone User Interface

You may also use the telephone interface to record and listen to your Auto Attendant greeting(s):

- Dial **651-789-7688** from your telephone and enter:
  - Auto Attendant phone number (provided by POPP)
  - 4-digit PIN (default PIN is 7677)
- Follow the prompts to record and listen to your Auto Attendant greetings
8.7 Troubleshooting

I have recorded my announcement, but when I try to play it back I cannot hear anything

- Verify that you have actually recorded something. The length of the current recording is shown as e.g. 0:01:35 (1 minute and 35 seconds). If the current recording length is 0 or much lower than expected, try recording your announcement again.
- Verify that playback volume is turned up high enough. Volume can be adjusted using the volume slider.
- Try re-recording the announcement, and as you are recording, watch the lights on the player:
  - If no lights appear, or only one or two appear, then check the following.
    - Increase the gain of your microphone by clicking on \[\text{\text{gain control}}\] and moving the gain control nearer to the top end.
    - Click on the \[\text{icon}\] to bring up the “Adobe Flash Player Settings” and make sure that the Allow option is selected. Click on the microphone icon at the bottom of this settings box and check that the correct microphone is selected in the dropdown, and that the record volume is turned up.
    - If you are using an external microphone, check that this is plugged in correctly.

If this still doesn't solve the problem, then it may be that your microphone has been muted by the operating system (e.g. Windows) - refer to your operating system help for further information.

- If several green lights appear consistently while recording your announcement, then it is likely that your announcement has recorded correctly and the problem is occurring when playing it back. If you are using external speakers, check that these are plugged in correctly and turned on. If this does not resolve the problem, then it may be that your speaker has been muted by the operating system (e.g. Windows) - refer to your operating system help for further information.

I have recorded my message, but when I try to play it back it is distorted

- This may be because your microphone gain is set too high. Reduce the gain by clicking on \[\text{\text{gain control}}\] and moving the gain control nearer to the bottom.
8.8 Configure Extensions Callers Can Dial

If you have chosen to offer your callers a Dial by Extension, Dial by Name, Voicemail by Extension or Voicemail by Name option, then you can configure the set of extensions they can dial in the following two ways. You can configure up to 200 extension numbers.

**Business Group Extensions**

Business Group extensions are the list of extensions within your business group. A list of all extensions in your business group is displayed in the Extensions tab.

To configure business group extensions to be included in Dial by Extension, Dial by Name, Voicemail by Extension or Voicemail by Name options:

- Click on the Business Group Extensions tab at the top of the Easy Attendant screen
- **Check the box** next to each extension to be included in the list available to callers and click **Include Selected**
- Included lines will display a check mark in the Included column
- Any new lines added to the business group will automatically be included in or excluded from the set available to callers, based on the **Automatically include new extensions as they are added to the Business Group** setting (at the bottom of the Extensions screen). Click on this setting to change it if desired.

To include selected lines in Dial by Name actions, you need to make sure that a name recording is available for the line. The name recording can come from one of two places:

- If the line does not have a name recorded for voicemail, record or upload a business group name recording by clicking the **Record** link for the line
- If the line already has a name recorded for voicemail, the voicemail name recording will be used as the Dial by Name recording. Click the green "override" link to record a business group name to be used instead.
- Lines with a business group name recording display a green "listen/change" link, allowing you to listen to or replace your existing recording.
- If a line has both a voicemail and a business group name recording available, the business group name recording will be used.
Additional Extensions

To use additional extensions, you must define the set of extensions which callers can dial. For each extension you must specify the 4-digit extension number, the extension's name and the phone number that your caller should be transferred to if they dial this extension.

To configure Additional Extensions:
- Click on the Additional Extensions tab at the top of the Easy Attendant screen
- Click on Add Extension:
  - **Extension**: This is the 4-digit extension number that your callers will dial. It cannot match any other extensions you have already configured.
  - **Name**: This is the name that your callers will dial. Both the first and last name must contain at least 2 dialable characters.
  - **Telephone Number**: This is the 10-digit telephone number that callers will be transferred to if they dial this extension
- You will also be prompted to record a spoken name for this extension. This is played to callers if they enter a name that is not unique to allow them to refine their search. For example, if there are two extensions called "John" and the caller enters "John", they hear the full names of both the extensions and can choose between them. Extensions that don't have a spoken name recorded can't be reached by "dial by name" options.

To delete existing extensions, check the box next to extension you wish to delete, and then click on Delete Selected.

8.9 Change Default Settings Premium Attendant Menus and Keys

Premium Attendant Advanced Settings

The Advanced tab allows you to configure the following settings for your Premium Attendant that will apply whenever you select a default value.

Default Keys

From the Advanced tab, you can use the Default keys tab to configure the default action for the keys on the telephone. This determines what each key will do if it is set to Use default in any of your Premium Attendant menus. You can modify the global behavior of the keys 1-9, 0, # and *. With the exception of Do Nothing, all these values are described in Configuring your Premium Attendant menu(s).

To change the existing default value for a key, select one of the following options from the drop-down box alongside the key:

- **Do Nothing**: if a caller presses a key that has this value, they will be told that the option is not recognized
- **Transfer to Phone**
- **Transfer to Voicemail**
- ‘Transfer to Operator’
- **Intercept Mailbox**
- **Dial by Extension**
- **Return to Previous Menu**
- **Replay Menu**
Error Handling

You can change the following global settings that determine what happens when there is an error when your callers are using Premium Attendant:

- **Timeout duration (in seconds):** This defines the behavior of Premium Attendant if a caller fails to press a key within the specified time.
  - Enter the time in seconds within which a caller should press a key (you can use any value between 0 and 10).
  - Enter the number of failures (up to 4) permitted before Premium Attendant performs the action set in the box below. After each attempt, a system prompt is played informing the caller that the option is not recognized.
  - Using the drop-down box, select the action that Premium Attendant will take once the caller has failed to press a key the specified number of times. Valid values are listed below.

- **Unknown input:** This defines the behavior of Premium Attendant if a caller presses a key that has not been assigned an action:
  - Enter the number of failures (up to 4) permitted before Premium Attendant performs the action set in the box below. After each attempt, a system prompt is played informing the caller that the option is not recognized.
  - Using the drop-down box, select the action that Premium Attendant will take once the caller has pressed an invalid key the specified number of times. Valid values are listed below. If you choose "Announcement - Hang up", you will be prompted to select the announcement that should be played.

- **Failed attended call transfers:** This defines the behavior of Premium Attendant if a call transfer fails to be connected.
  - Using the drop-down box, select the action that Premium Attendant will take if the call transfer fails initially.
  - Enter the number of failures (up to 4) permitted before Premium Attendant performs the action set in the box below.
  - Using the drop-down box, select the action that Premium Attendant will take once the call transfer has failed the specified number of times. Valid values are listed below. An additional input box will appear if the action requires it, for example you will be prompted to enter a phone number if you select 'Transfer to Phone'.

- **Invalid extensions:** This determines the behavior of Premium Attendant if a caller presses an extension number that it does not recognize.
  - Enter the number of failures (up to 4) permitted before Premium Attendant performs the action set in the box below.
  - Using the drop-down box, select the action that Premium Attendant will take after the specified number of failures to connect to a valid extension. Valid values are listed below. An additional input box will appear if the action requires it, for example you will be prompted to enter a phone number if you select 'Transfer to Phone'.

The following actions can be selected for the above default settings:

- System Announcement then Hang up - although you can only use action this for timeout and unknown input settings
  - Transfer to Phone
  - Transfer to Voicemail
  - Transfer to Operator
  - Intercept mailbox
  - Replay Current Menu
  - Announcement - Hang up
  - Hang up

You will see an error icon next to the misconfigured event if you have made any errors in changing the default configuration for your Premium Attendant.
The Other Settings tab allows you to:

- Set whether Dial by Name or Voicemail by Name key presses match on First and last name (default), or just first name or just last name
- Set the number for the mailbox to be used on the Intercept Mailbox action. This number will be used by every Premium Attendant menu that uses this option on a key. Error message pop-up if this number doesn't correspond to a voicemail account.

8.10 Turning Premium Attendant On/Off

To turn your Premium Attendant on or off:

- Navigate to the Main tab at the top of the Premium Attendant screen and click the Turn ON or Turn OFF button.

When your Premium Attendant is turned off, callers will either hear an announcement stating that “this number is unreachable” or will be forwarded to a number of your choice. It is common to leave your Premium Attendant turned on all of the time, but (depending upon how Premium Attendant has been deployed) you may, for example, wish to turn Premium Attendant off during the day and forward your callers directly to a live receptionist instead.

8.11 Forward Calls when Premium Attendant is Off

When your Premium Attendant is turned off, you can choose either for callers to:

- Hear a message telling them that the number is unreachable
- Be forwarded to an alternative number

To change this setting, your Premium Attendant must first be turned off. The text at the top of the Main Premium Attendant tab will then read either “Your Premium Attendant is currently OFF and callers will be told that this number is unreachable”, or “Your Premium Attendant is currently OFF and callers are being forwarded to [nnn-nnn-nnnn]”. To change the current setting, click on the link included in this message.
9 Phones

The **Phones** screen allows you to manage the telephones in a business group and to assign them to business group lines.

![Business Group Admin Portal](image)

A Phone Profile is a set of configurations for a physical telephone. Phone Profiles can exist at several levels:

- Globally
- For a Business Group
- For a Department
- For a Business Group Line

Where multiple Phone Profiles apply to a physical telephone, they are applied in the above order so, for example, any settings from the Department Phone Profile override settings from the global Phone Profile.

### 9.1 Select a Department

Use the **Phones in Department** dropdown field to select the Department to display the Phones for.

A Department defines a section of a Business Group to which Lines and other functions, such as Short Codes, can be assigned. Administrator privileges for the Department can be assigned to a particular Business Group Line, without giving the Line access to the whole Business Group.

### 9.2 Find Phones

If you only have a few telephones in your business group or selected department, you may be able to find a telephone by manually looking at the list of Phones.

Alternatively, you can search for the telephone you are interested in based on MAC address, description or phone number. Enter the MAC address, description or phone number you are searching for in the **Search for**... field and the list of telephones will automatically update to only show telephones that match. If you wish, you can restrict your search to only match on a given field by using the drop-down to the right of the search field.

### 9.3 Telephone Configuration

See Telephone Configuration user guides on popp.com/support > Portals

### 9.4 Copying Telephone Configuration

To copy the configuration from one telephone to another:

- Modify the old telephone as the **User**, by clicking on the **Individual Line icon** to the right of the telephone
- Go to the table view by clicking on the **table view icon** on the bottom right side of the screen
- Select the **Phone Profile** object.
- Select **Edit ➔ Copy**.
• Close the window to exit the Phone Configuration screen
• Log into the new telephone as the User
• Go to the table view
• Select the Phone Profile object.
• Select Edit → Paste
• Click on Save Changes

Replacing with an identical telephone model

To replace a telephone with one of an identical model, follow these steps:
• In the User Portal:
  o Copy the configuration of the existing telephone to the new telephone by following the instructions for Copying telephone configuration section above
  o Remove the existing telephone from the phone line
  o Add the new telephone to the line which was removed from the old line
    Note: The new telephone must be in the same department as the telephone being replaced. If it isn’t, you or another administrator with sufficient permissions must move the telephone to the appropriate department before you can assign the line to it.
• Unplug the computer’s Ethernet cable from the old telephone if one is plugged in
• Unplug the telephone Ethernet cable form the old telephone
• Plug the computer’s Ethernet cable into the PC socket of the new telephone
• Plug the telephone Ethernet cable into the new telephone
• The new telephone should now power up and retrieve its configuration from the server. The new telephone will be configured identically to the old one.

9.5 View Phones

In the Phones screen, each row in the table shows the following for each phone:
• Model: Phone model image
• MAC Address: The address that uniquely identifies the physical phone
• Description: A description of the phone
• Assigned To: Multiple phones can be assigned to the same phone number.
• Department: The department that the phone is assigned to. Each phone may only be assigned to one Department.
• Click Actions and select Configure phone to configure this phone

9.6 Assign a Phone to a Department

To assign a phone to a new department:
• To select all phones, check the box next to Model at the top of the Model column. Select one or more phones by checking the box next to each individual phone in the list.
• Select the Department to move the phone(s) to, using the Select Department drop-down field
• Click Assign to Department to make the change
  Note: Assigning a phone to a different department will unassign the line from the phone. A line may be assigned to the phone after the phone has been moved to the new department. The line and phone must be assigned to the same department.

9.7 Assign a Phone to a Business Group Line

To assign a phone to a business group line:
• To select all phones, check the box next to Model at the top of the Model column. Select one or more phones by checking the box next to each individual phone in the list.
• Enter the phone number of the business group line to assign the phone(s) to, using the Enter number... field
• Click Assign to Line to make the change
9.8 Change Phone Information

To change phone information:
- Click on the Actions drop-down to the right of the phone and select Change phone to change:
  - Description
  - Expansion Modules: These are add-ons to the Phone that provide additional keys
  - Assigned to Line? Whether or not the Phone is assigned to a line, and the line's phone number
    - If you wish to unassign the Phone from a line altogether, simply uncheck the checkbox in the Assigned to line? field.
- Click Apply to save changes

10 Departments

Click on the Departments menu option to see all departments for the business group.

Departments divide your business group into separately-administrable groups. Administrators can optionally be restricted so that they only have privileges to administer lines within a given Department. Departments may be divided into sub-departments.

10.1 View Department

On the Departments screen, the following information is shown for each department:
- Department Name: Department names are indented to show their sub-departments and the Department of which they are a sub-department (if applicable)
- Operator Number: Phone number that calls are transferred to when callers dial “0” from within voice mail
- Call Limits: Limits in the number of calls this department can make

10.2 Add a Department

To add a Department:
- From the Departments screen, click Add Department
- Department Name: Enter a new department name
- Parent Department: Select the department of which the new department should be a sub-department
- Operator Number: Phone number that calls are transferred to when callers dial “0” from within voice mail
- Set limits on the number of calls this department can make: Set call limits (if applicable)
- Click Add

10.3 Delete a Department

To delete a department:
- Ensure that the Department is empty of lines, phones, call pickup groups, short codes and other departments. Departments can't be deleted unless they are empty.
- From the Departments screen click on the Department
- Click Delete

If you find that you can't delete a department because it is not empty, check that the department has no sub-departments and also check for entries in this department on the lines, phones, call pickup groups, short codes and departments pages. If you find any lines, phones, call pickup groups, short codes or other departments, either delete them or move them into other departments.
10.4 Edit Department

To edit a Department's name:
- From the Departments screen click on the Department
- Department Name: enter the new department name
- Click Apply

To edit a Department's operator number:
- From the Departments screen click on the Department
- Operator Number: enter the new operator number
- Click Apply

To remove a sub-department's operator number and have it inherited from above:
- From the Departments screen click on the Department
- Operator Number: delete the operator number
- Click Apply

10.5 Department Call Limits

Call limits control how many calls are permitted into and out of a department. The call limits you set for a particular department apply to that part of the department “tree” (a department and all sub-departments below it). Calls within that part of the tree (within the department, or between two sub-departments) do not count toward these limits, but calls to or from departments elsewhere in the business group or outside of the business group are counted. Make sure you set this limit high enough to account for all the departments below this one.

Three different types of limits can be specified:
- Incoming and Outgoing: This limits the total number of calls into and out of the department or its sub-departments
- Incoming: This limits the number of calls into this department or its sub-departments
- Outgoing: This limits the number of calls out of this department or its sub-departments

For each type of limit, calls can be:
- Limited: Only a specific number of calls are permitted
- Blocked: No calls are permitted
- Unlimited: Any number of calls are permitted for this department and its sub-departments, although calls may still be restricted by limits set on a department higher or lower in the tree

To edit a Department's call limits:
- Click on the Department name
- Select whether each call type is Unlimited, Limited, or Blocked
- If Limited: Specify the maximum number of calls of this type
- Click Apply to save

11 Short Codes

The Short Codes page shows all Short Codes currently in operation in a Department.

A Short Code is a 1-7 digit code, specific to the Business Group, which can be used to access external numbers or as substitutes for standard access codes (star codes).

11.1 View Short Codes

Click on the Short Codes menu option on the left side of the screen. To display short codes for a specific department, select the department from the Short Codes in Department drop-down field.
A Department defines a section of a Business Group to which Lines and other functions, such as Short Codes, can be assigned. Administrator privileges for the Department can be assigned to a particular Business Group Line, without giving the Line access to the whole Business Group.

Each row in the table shows the following for each Short Code:

- **Short Code**: This is either a single code or a range of codes
  - **Telephone Number or Service Access Code** (star code, i.e., *55): Star code that the short code maps to (this may be blank if not assigned yet) or range of phone numbers
- **Department**: Department assigned to the short code

### 11.2 Add a Short Code

To add a Short Code to the current Department:
- Click **Add**
- **Short Code**: enter short code
- **Maps to**: Select Telephone Number or Service Access Code
- Enter a **Telephone Number** or **Service Access Code** (star code) that the short code maps to
- **Department**: Select a department (optional)
- Click **Add**

### 11.3 Add a Short Code Range

To add a range of Short Codes to the current Department:
- Click **Add Range**
- **Range of Short Codes**: Enter the first and last short code in the range
- **First Telephone Number**: Enter the first phone number that the range maps to
- **Department**: Select a department (optional)
- Click **Add**

### 11.4 Remove a Short Code or Short Code Range

To remove a Short Code or Short Code Range:
- Check the box next to each Short Code/Short Code Range to be deleted
- Click **Delete Selected** to save changes

### 11.5 Modify a Short Code

To modify a Short Code:
- Click on the short code in the list
- Change the **Short Code** or **Range of Short Codes** as required
- Change the **Telephone Number/Service Access Code** (star code) as required
- Click **Save** to save

### 11.6 Move Short Codes between Departments

To move Short Codes between Departments:
- Check the box next to each Short Code/Short Code Range to be moved
- **Move selected to**: Select the department to move the Short Codes to
- Click **Move** to save
12 Extensions

Click on the Extensions menu option on the left side of the screen. This screen displays all Extensions currently in operation in the business group.

An Extension is a 4-digit number that allows your end users to quickly dial another number within the business group. Extension numbers may not start with a “0” (used to dial the operator).

12.1 View Extensions

The Extensions screen displays the following information for each Extension/Extension Range:

- **Extension**: This is either a single extension number or range of extensions
- **Telephone Number**: This is the phone number that the extension maps to. For an extension range, this is the range of phone numbers that the extension range maps to.

12.2 Add or Remove Extensions

The number extensions configuration is read-only and cannot be changed via the portal. To add or remove extensions, contact POPP at 763-797-7900.

13 Call Analytics

The Call Analytics screen allows you to view a Summary of statistics for your business group, add or manage pre-defined BG (Business Group) or ACD (aka HCC – Hosted Call Center) Reports, or Download Logs as a CSV file for all calls. Click the Call Analytics menu option on the left side of the screen for this information.

13.1 Summary

The Summary tab displays statistics on calls, average call duration, and average alerting duration.
13.2 Reports

The Reports (aka Call Analytics) tab is used to manage and add new reports.

Create a New Report

- To create a report, click on New Report to launch a new window to create the report
- Administrators can only view information for the business group/departments they manage (and any of their sub-departments)
- You can schedule a report to be automatically generated at a point in the future. This can be a one-off report covering a pre-defined time period, or a recurring report that is generated on a daily or weekly basis. Reports are sent as PDF files to one or more e-mail addresses of your choosing.
- Only business group administrators can generate reports, but reports can be e-mailed to any recipients entered by the administrator when creating the report.

Enter report details:
- Report Title – enter a title for this report
- If you are also a Hosted Call Center (HCC) Supervisor, you will see ACD (HCC) and BG (Business Group) radio buttons below the Report Title box. Select BG to generate a business group report.
- Report Type – select the type of report from the drop-down. See Call Activity Report Types section below for details.
- Department – select the department for which you want to generate the report
- Optional fields:
  - Line Filter (optional) – to filter the report to only contain information for a specific line, enter the line number
  - Account Code (optional) – to filter the report to only contain information for a specific account code, enter the account code

Note:
- If you enter both a Department and a Line, and the line is not in that department, the report will include calls between that line and anyone in the department.
- If you enter both a Department and an Account Code, the report will include all calls from that department using the account code (e.g., if an account code relates to a specific customer, you can use the Account Code filter to generate a report that will collate all outgoing calls from different lines to that customer)

- Enter Data range to set the dates and times (working hours) the report should include:
  - Period – enter/select start and end date
  - Start of day – use the drop-down to select the required time period (e.g., 8 am)
  - End of day – use the drop-down to select the required time period (e.g., 5 pm)
  - Days of the week – click on the icons for the days of the week to include/exclude those days from the report

Note: If you want the report to cover less than a whole day, use the Start of day/End of day drop-downs to select the required time period.

- Click Update Report to display the report on the screen
- Schedule – select one:
  - One Off - generate report one time
  - Daily – generate report once daily
  - Weekly – generate report once per week on the specified date selected in the “Due” field
- Send to - enter the e-mail address(es) of people who should receive a copy of the report via e-mail each time it’s generated
- Click Save to save this report and launch the Report Schedule Manager in a new window or click Cancel to cancel
## Manage Scheduled Reports

- To manage scheduled reports, click on **Manage Reports** to launch the **Report Schedule Manager** in a new window. This screen displays details of the reports you currently have scheduled.

- Click **Edit** alongside a report to make any changes to report details
- Click **Delete** to delete a report
- Click **Clone** to create another report of this type using the same parameters as this one. The report will be created with the appropriate fields already filled in.
- You can also add a new report from this screen by clicking on **Add a new report** at the top of the screen

### Notes:
- There is a maximum of 50 scheduled reports per business group. If this limit has been reached, the option to add a scheduled report will be grayed out and you will need to delete one or more existing scheduled reports before you can add a new one.
- For more information and to view samples of Call Analytics and/or Hosted Call Center (HCC) reports, see user guides on popp.com.

## 13.3 Download Logs

- Click on the **Download Logs** tab
- **Start date**: Enter the month, day, and year, or select the start date by clicking on the calendar icon.
- **End date**: Enter the month, day, and year, or select the end date by clicking on the calendar icon.
  - **Note**: Start and end dates must be no more than 30 days apart.
- **Select department** (optional): Select a specific department
- Click **Download**
- The report will download (this may take some time)
- Choose a location where you would like to save the report

Once you have downloaded the report, you can open it in a spreadsheet application (e.g., Microsoft Excel). The report includes the following fields for each call:

- **Date**: Date the call was made
- **Time**: Time the call was made
- **Call Type**: Indicates whether the call was:
  - **Intra BG**: A station to station call
  - **Terminating**: A call into the business
  - **Originating**: A call from the business
- **Called Number**: Phone number that was called
- **Called Extension**: Extension that was called
- **Called Department**: Department that was called
- **Call Connected**: Whether the call was answered (Yes/No)
- **Duration**: Length of the call
- **Queuing Time**: How long the caller was waiting for the call to be answered
- **Account Code**: Indicates if an account code was used to make the call (if applicable)
- **Carrier Code**: Indicates if a carrier code was used to make the call (if applicable)

**Note**: If you filter the call logs report by department and your department was recently renamed, you will only see calls that were made since the renaming.
14 Music on Hold

The **Music on Hold** administration system allows administrators to configure music and recordings that callers will hear while they are on hold. You can select from existing music options that POPP has made available or upload your own personalized recordings.

14.1 View Music on Hold

Click on the **Music on Hold** menu option on the left side of the screen to open the Music on Hold administration system.

Administrators will see three tabs at the top of the page:

- **Security**: View and configure your security settings
- **Mappings**: Configure different recordings to be played when specific lines within your business put callers on hold
- **Resources**: Upload and manage your recordings (administrators only)

Non-administrators will only see the Resources tab and will not have the ability to manage recordings.

14.2 Resources
Global Media List
The Global Media List section specifies any recordings that POPP has made available for your use. You cannot add or remove recordings from the Global Media List. Each recording has been assigned a 2-digit ID number that you will need to enter when using the Telephone User Interface to listen to the recordings.

Local Resource List
The Local Resource List displays any recordings that you have uploaded to the Music on Hold system using the web interface or via the telephone.

Recording Limits
At the bottom of this section you will see:
- **Disk Used:** MB of storage you have used of the storage you are allowed (15 MB max)
- **Resources:** Number of recordings you have uploaded of the recordings you are allowed (10 max)
  
  **Note:** The Music on Hold system will not allow you to exceed either your storage limit or the maximum number of recordings allowed.

### 14.3 Recordings

**Add a recording**
You can upload recordings to the Music on Hold system in either a WAV (.wav) or MP3 (.mp3) format.

To add a recording:
- **ID:** Enter an ID for this recording (must be a 2-digit number between 10 and 99 and cannot match the ID of another recording)
- **Description:** Enter a description for this recording
- Click on **Choose File**, select the recording you wish to upload and click on **Open**. This must be either a .wav or .mp3 file.
- Click **Add** to add the recording

Depending on the size of the recording you are uploading, this process may take a few seconds to complete.

**Edit a recording**
To change the Description:
- Click on **Edit** to the right of the recording
- **Description:** Enter the new description
- Click **Save**

To change the volume at which a recording will play:
- Click on **Edit** to the right of the recording
- **Gain:** Select a new gain value from the drop-down list
  - Select 0 to play the recording at its original volume
  - Select +1, +2 or +3 to play the recording louder, with +3 being the loudest
  - Select -1, -2 or -3 to play the recording quieter, with -3 being the quietest
- Click **Save**

**Play a recording**
You can play a recording that you have uploaded by clicking on the **ID** or **Description** link for that recording.

**Note:** The recording will play at its original volume. The Gain setting has no impact on the volume when the recording is played through the Music on Hold interface. You can listen to the recording with the Gain (volume) setting applied by listening to the recording using the telephone interface. See Music on Hold **Telephone User Interface** section for more information.

**Delete a recording**
Click on **Delete** to the right of the recording you wish to delete.
The Mappings screen lists directory numbers of lines in your business group or department and the Music on Hold resource(s) assigned to each line. You can assign one recording to all lines or assign different recordings to each line.

### Sub-departments
If your department has one or more sub-departments, you will see View mappings in each sub-department along with a link to each of the sub-departments at the bottom of the screen.

To view/modify the mappings for lines in a sub-department:
- Click on the link for the desired **sub-department**
- A link for the parent department will appear at the top of the screen. Click on this link to return to the mappings screen for the parent department.
- **Directory Number:** Each line assigned to the department will be listed
- The Default mapping is used when a mapping is not specified for a particular line
- Each mapping consists of the following fields:
  - **Directory number:** Line number
  - **Initial resource:** Global (POPP-provided) or Local (Client-provided) resource/recording to be played when a call is put on hold
  - **Action** - one of the following:
    - **Repeat:** The initial resource/recording is played continually
    - **Play Once:** The initial resource/recording is played once, and then the follow-up resource/recording is played continually.
    - **Repeat - Initial interrupted:** The initial recording should be interrupted at set intervals by the follow-up recording. For example: To interrupt music with an announcement indicating that the User is in a queue.
    - **Repeat - Follow-up interrupted:** The initial recording is played first. Then the follow-up recording plays continually being interrupted by the first recording.
  - **Follow-up resource:** The recording which may be played depending on the Action selected
  - **Start Point:** Indicates whether the recording will start at the beginning (the value Start indicates this) or whether it should start at a random point of the recording (the value Random indicates this).
  - **Duration:** Used only by the Repeat – Initial Interrupted and Repeat – Follow-up Interrupted actions to indicate how often the repeated recording should be interrupted.

### Add a mapping
To add a mapping for a particular line, follow these steps:
- Select a **Directory number**
- Select an **Initial resource**
- Select an **Action**
- Select a **Follow-up resource** (not applicable if Action of “Repeat” is selected)
- Select a **Start Point**
- Select a **Duration** (only if Repeat – Initial Interrupted or Repeat – Follow-up Interrupted Action is selected)
- Click on **Add**

### Edit a mapping
To edit the default mapping or the mapping for a specific line:
- Click **Edit** to the right of the mapping.
- Modify the desired fields
- Click on **Save**

To change the Directory number for a mapping, you must delete the current mapping and then add the mapping for the new Directory number.
14.5 Telephone User Interface

In addition to the Administrator Portal, the Music on Hold system can be accessed via telephone.

Using the telephone interface, you can:

- Listen to music or other recordings for the default mapping or mapping(s) you have configured for any of your lines.
- Listen to music resources that POPP has made available in the Global Media List.
- Add, change or delete your own recordings.

Access

To access the telephone interface for Music on Hold, dial 763-231-0491 from your telephone and enter:

- Your phone number
- Your 4-digit Music on Hold PIN (default PIN is 7677). See the Music on Hold Security section for instructions to change your PIN.

Using the telephone interface

Listen to the voice prompts and press the key on your telephone for the option you would like to select.

Press * at any time to go back to the previous menu.

The main menu options in the telephone interface are:

- **Listen to resource for default mapping**: Select this option to listen to the recording that will play to callers on hold on all lines that do not have a specific mapping assigned.
- **Listen to resource for particular extension**: Select this option to listen to the recording that will play to callers on hold on a particular extension.
- **Listen to global resources**: Select this option to listen to the recordings that POPP has made available in the Global Media List, described in the Music on Hold Resources section. You will need to enter the 2-digit resource ID of the recording you want to listen to.
- **Manage existing local resources**: Select this option to modify or delete recordings you have added to the Music on Hold system, including recording a new resource to replace an existing one. You will need to enter the 2-digit resource ID of the recording you want to modify or delete.
- **Record new local resource**: Select this option to record a new resource over the telephone.

Security

To change the Admin PIN for telephone access:

- Enter the new 4-digit PIN in the text box
- Click Apply
15 Misc. Settings

The Miscellaneous Settings screen gives administrators access to the Number Blocks and External Calls settings and Other Settings (settings for business group-wide functions).

15.1 Number Blocks

The Number Block tab displays a list of number blocks configured for the business group.

A Number Block defines a range of directory numbers (DIDs) used for lines in the business group.

The following information is displayed for each number block:

- **Telephone Number Block**: Range of telephone numbers in the Number Block
- **Number of Lines Allocated**: Number of directory numbers in the Number Block to which lines have been assigned.

The number block configuration is read-only and cannot be changed via the portal. If you wish to change the configuration of a telephone number block, please contact POPP at 763-797-7900.

15.2 External Calls

The External Calls tab displays any limits on External Calls, Incoming Calls, or Outgoing Calls along with the default carriers that are used when making calls.

The External Calls can be one of the following:

- **Unlimited**: There is no limit on the number of concurrent external calls, but there may be a limit on the number of incoming or outgoing calls allowed.
- **Limited**: In this case the maximum number of concurrent external calls is also shown
- **Not permitted**: Calls to and from phone numbers outside of the Business Group are not permitted.

Incoming Calls can be one of the following:

- **Unlimited**: There is no limit on the number of concurrent incoming external calls, but there may be a limit on the number of external calls allowed.
- **Limited**: In this case the maximum number of concurrent incoming calls is also shown
- **Not permitted**: Inbound calls from phone numbers outside of the Business Group are not permitted.

Outgoing Calls can be one of the following:

- **Unlimited**: There is no limit on the number of concurrent outgoing external calls, but there may be a limit on the number of external calls allowed
- **Limited**: In this case the maximum number of concurrent outgoing calls is also shown
- **Not permitted**: Outgoing calls to phone numbers outside of the Business Group are not permitted.

Local Carrier Code: This is a code that identifies your default local carrier (0477 is POPP Communications).

Long Distance Carrier Code: This is a code that identifies your default long distance carrier (0477 is POPP Communications).
15.3 **Other Settings**

The **Other Settings** tab contains the following business group-wide settings:

**Restricted Subscriber Messaging:**
To prevent the forwarding of voicemail messages to subscribers outside of the business group, check this box and click **Apply**.

**Use Internal Extensions**
To display business group extensions rather than directory numbers when possible, check this box and click **Apply**.

**Internal Operator Number**
To change the operator number for the business group as a whole, enter the number you want and click **Apply**.

16 **Additional Information**

**For additional training and support:**
- Visit www.popp.com or call POPP Communications at 763-797-7900